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Tanusitvanyok hasznalata
Microsoft Office 2010 alkalmazasbol

Windows operacios rendszeren tanusitvanytarban, PFX fajlban, vagy
kriptografia eszk6z6kon talalhato tandsitvanyok esetén
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2. Bevezetd

Ennek a tajékoztaténak az a célja, hogy az elektronikus alairashoz és/vagy titkositashoz
hasznalhaté szoftverek beallitisa minél z6kken6é mentesebben megtorténjen, illetve hogy a
hasznalat kbnnyen elsajatithat6 legyen.

Amennyiben barmilyen kérdése van vagy problémaja timad, Ugyfélszolgilatunk a(z) +36 1 437
6655 telefonszamon, az info@netlock.hu e-mail cimen vagy személyesen a 1101 Budapest, Expo
tér 5-7. szam alatt hétf6tdl - csuitortokig 8:30 és 17 ora kozott pénteken 8:30 és 14 6ra kozott
készséggel all rendelkezésére

3. A Microsoft Office 2010-161

A Microsoft Office 2010 egy tobb alkalmazast tartalmazé irodai programcsomag, melyek kozil
egyes komponensek rendelkeznek digitalis alafrast timogaté részekkel.

A csomag digitalis alafrast tiamogatorészei:
Excel tablazatkezel

PowerPoint  prezentacié (bemutatd) készité
Word szOvegszerkeszté

Tovabba Word és Excel esetében megjelent az Alairasi mez6 beszurasa funkci, mely egy
hasznos 4j eszkdz, és melynek hasznalatat szintén targyalja ezen dokumentacio.

4. Opericios rendszer kévetelmények

A tanusitvanyok hasznalatahoz ajanlott minimum operacios rendszer kévetelmény:
Windows XP SP3

Vista SP1

Windows 7

5. Aktudlis szerviz csomag az SHAZ256 algoritmusti tanusitvany hasznalatahoz

Az SHA256 algoritmusu alair6 és titkosité tanusitvanyok kezeléséhez az alabbi frissitésre lehet
szitkség, amennyiben nem naprakész az Office2010.
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6. Formitum korlitozisok

Az Office 2010 lehet6vé teszi, hogy 97-2003 verzidéval kompatibilis mentést hajtsunk végre az
alkalmazasbol.

A digitalisan alairt dokumentumokrél egy ilyen fajlformatum valtas soran az alairas lekeril, azt az
4j formatumban mentett fajl esetén vjra ala kell irni.

Office 2010-ben kompatibilis formaban mentve, és alafrva és Office 2003-ban a digitélis alairas
jelzés nem latszik azonban a dokumentum alairt.

Office 2003-ban aléirva, Office 2010-ben megnyitva az alairas latszik és érvényes a jelzése is.

6.1. A Microsoft Office 2010 alkalmazas tamisitvanykezelése

6.2. Rovid dttekintés a tanuisitvany igénylési - és tdrolisi megoldisokrol

A tanusitvanyok létrehozasa ¢s tarolasa tobbféleképpen torténhet. Ezek killonbségeirdl olvashat a
kovetkez6kben, amely hasznos lehet a beallitishoz. Természetesen a beallitas elvégezhet6 ezen
révid attekintés elolvasasa nélkil, de amennyiben 4j digitalis alairds hasznald, javasoljuk elolvasni.

6.3. Tanusitviny igénylése Mozilla bongészon keresztiil

A Mozilla bongészbk, levelez6k a tébb operacidés rendszeren hasznalhatésig érdekében a
tanusitvanyokat egy-egy sajat védett taroléban taroljak, melyhez csak az adott, illetve az ezt
megfelel6en kezelni tud6 alkalmazas fér hozza, az operacids rendszer iranyabol nem latszik.

Amikor Mozilla bongészével hoz 1étre weboldalunkon egy kérelmet, akkor a privat kulcs a
bongészé sajat taraban jon létre, ott tarolodik, és a késébb kiadott tanusitvanyt a Mozilla
bongészével az tgyfélment importalas pontjat valasztva helyezi be véglegesen a taroldba, ez utan
lesz az hasznalhaté.

Ekkor készithet réla biztonsagi mentést, mely a szabvanyos PKCS#12 (vagy masik nevén PFX)
fajlformatumban jon létre.

Fontos megjegyezni, hogy a bongészé is védi ezt a kulcsot (Mesterjelsz6), amit elsé alkalommal
On allit be, amennyiben ezt a jelszot elfelejti, nincs lehet6ség a késébbiekben sem a tanusitvany
hasznalatara, ezért a béngész6 védelmi jelszavat biztonsagosan tarolja.

Mivel minden egyes Mozilla termék, kilon tandsitvanytarral rendelkezik, ha masik Mozilla
termékbdl kivanja hasznalni tanusitvanyat, arrdl itt mentést kell készitenie, és oda is telepitenie
kell azt.

Fontos! A tanusitvanykérelem beadasa (kulcsgeneralas) és az elkészilt tanudsitvany importalasa
kozotti idészakban, ne telepitse ujra operacids rendszerét, se bongészdjét, mivel ezzel
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helyreallithatatlanul t6rli a tanudsitvanyahoz tartoz6 privat kulcsot is; e nélkil pedig az
hasznalhatatlan lesz.

6.4. Tanusitviny igénylése Internet Exploreren keresztiil

A Windows operacios rendszer biztosit egy kézponti tandsitvany tarat, amelyet az alkalmazasok,
amelyeket erre felkészitettek, elérhetnek. Ehhez a tarhoz fér hozza a teljesség igénye nélkil a
Microsoft Internet Explorer, az Outlook és Outlook Express programok, illetve a digitalis
alairasra képes Office alkalmazasok is.

Amikor Internet Explorer béngészével hoz létre weboldalunkon egy kérelmet, akkor a privat
kulcs a Windows operacioés rendszer tanusitvanytaraban jon létre, ott tarolodik, és a késSbb
kiadott tanusitvanyt az Internet Explorer bongészével, az tgyfélmenii importalds pontjat
valasztva helyezi be véglegesen a taroloba, ez utan lesz az hasznalhato.

Ekkor készithet réla biztonsagi mentést, mely a szabvanyos PKCS#12 (vagy masik nevén PFX)
fajlformatumban jon létre.

Fontos! A tanusitvanykérelem beaddsa (kulcsgeneralas) és az kiadott tanusitvany importalasa
kozotti id6szakban ne telepitse Gjra operacios rendszerét, se bongészdjét, mivel ezzel
helyreallithatatlanul t6rli a tanudsitvanyahoz tartozé privat kulcsot is, e nélkil pedig az
hasznalhatatlan lesz.

6.5. Tanusitviny és kulcsok kriptogrifiai eszkézon (kartydn, tokenen)

Igen népszerti igénylési moéd a tanusitvanyok kartyan vagy tokenen vald igénylése, mely az
eszk6zok és a hozza tartozé PIN kéd miatt egy fokkal magasabb biztonsagot is nyujt.

Az ilyen eszk6zokben a privat kules biztonsdgosan tarolodik, az egyes alairasi méveletek kézben
sem kertl ki az eszk6zbdl, hanem az kapja meg a feladatot, és PIN kéd kérés utan adja vissza az
eredményt.

Amikor egy ilyen eszkozt hasznal, akkor el6tte természetesen a meghajté (driver) programokat
telepitenie kell a gépre, melyek telepitése soran az eszkéz a Windows tanusitvanytaraval magas
fokon integralodik, tehat Windows tanusitvanytarat hasznal6 alkalmazasok (a teljesség igénye
nélkil: a Microsoft Internet Explorer, az Outlook és Outlook Express programok, illetve a
digitalis alairasra képes Office alkalmazasok) rogton hasznalni tudjak.

Amennyiben az alkalmazas NEM hasznalja a Windows tanusitvany tarat (példaul Mozilla
programok) természetesen meg kell mondani az alkalmazasnak, hogy hogyan éri el az eszkozt.
Ezért bonyolultabb példaul a Mozilla programok beallitasa.

Az ilyen eszk6zo6n kiadott tandsitvanyokrdl egyébként nem tud PKCS#12 (vagy masik nevén
PFX) mentést csinalni, mert a kartyardl a privat kulcs nem szedhet6 ki.
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6.6. Tanusitvany és kulcsok PKCS#12 (PFX) dllomznyban

Mint az el6bbiekben olvashatta, a PKCS#12 (vagy masik nevén PFX) fijlformatum alapvetéen
biztonsagi mentés, illetve kulcsok és tanusitvanyok egylittes mozgatasa gépek kozott céljara
szolgalhat. Ilyen formaban tanudsitvanyt nem tud igényelni, hanem csak 1étrehozni tudja azokat,
melyeket helyreallitasi céllal egyébként is lényeges megtennie.

7. A tanusitvdnyok telepitése

Az el6z6 fejezetekben attekintetteknek megfeleléen, a kévetkezSk leirjak, hogyan tudja a
tanusitvanyat beallitani a hasznalathoz.

7.1. Ha a tanusitvany kdrtydn, tokenen talilhato

Amennyiben tanusitvanyat kriptografiai eszk6zon kapta meg, akkor a kriptografiai eszkoz
telepitési utmutatéja leirja, hogyan importalhaté a tandsitvany a Windows tanudsitvanytarba.
Kérjik, hajtsa végre az ott leirtakat.

7.2. Ha a tanusitvany mar a gépen talilhato

Ha a tanusitvany a tanudsitvany igénylését (fokozott biztonsagu tanusitvany esetén) Internet
Explorerbdl intézte, a tandsitvany kiadasi folyamat végén a tanusitvany és a kulcsok
megtalalhatok az On gépén.

Ekkor nincs szikség a tanusitvany telepitésére, azonban biztonsagi masolatot érdemes
létrehoznia.

7.3. Ha a tanusitvanykérelem beadisa Mozilla béngészon keresztiil tortént

Amennyiben a kérelmet Mozilla bongészén keresztiil adta be, a késébb kiadott tandsitvanyt a
Mozilla bongész6vel, a NetLock tgyfélmentijébe belépve (itt: Tanusitvanyok mentipont> Kiadott
tanudsitvanyok) az importalas pontot valasztva tudja véglegesen Modzilla sajat tanusitvanytarolojaba
behelyezni, majd ezt importalnia kell, és a Windows tanusitvany tarba telepitenie.

7

7.3.1. Tanusitvany exportilisa Firefox bongészébél Windows tamisitvianytiarba
telepitéshez

A Firefox bongész6 az egyik leggyakoribb Mozilla bongész6, ezért a PKCS#12 mentés készitését
ezen mutatjuk be, a tobbi Mozilla termék PKCS#12 mentés készitését az adott termékhez késziilt
dokumentacié mutatja be.
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1. Inditsa el a Firefox bongészét.

2. Navigaljon el a Tanusitvanyok mentpontig. Eszk6z6k > Beallitaisok > Haladé >
Titkositas ful > Tanusitvanykezel6 gomb (Tools > Options > Advanced > Encryption
ful > Manage certificates gomb).

3. A megjelené ablakban a Sajat tanusitvanyok (Your certificates) filon valassza ki
mentend$ tanusitvanyt, majd nyomja meg a Mentés (Backup) gombot.

A kovetkez6 ablakban adja meg a mentés helyét.

5. Ezt kovetéen adja meg Firefox-on beluli tanusitvanyvédelmi jelszét. (mestetjelsz6 /
master password) (Ez az elsé tanusitvany export-import elStt nincs bedllitva, ekkor
kétszer kell begépelnie, és a késébbick soran ez utin fog rendszeresen érdeklédni a
Firefox bongészd.)

6. Ezutan adja meg a .pfx fajl jelszavat, amellyel védeni kivanja, ezt a jelszot jegyezze is fel.

7. A mentés utan tajékoztatast kap, hogy az sikeresen megtortént, majd nyomjon Ok
gombot az Osszes ablak bezar6dasaig.

A tanusitvany exportalasa ezzel megtortént. Javasolt az exportalt allomanyt a telepités utan, mint
biztonsagi masolatot biztonsagos helyre eltenni.

A kovetkez6 fejezet ismerteti a PKCS#12 allomanyok telepitését.

7.4. PKCS12 (PFX) fajlban talilhato tamisitvdny telepitése Windows taniisitvinytdrba

Abban az esetben, ha tandsitvanyat nem kriptografiai eszk6zon szerezte be, és nem Internet
Explorer bongészén keresztil igényelte, akkor az arrél készilt PKCS#12 (pfx) formatumu
mentett allomany segitségével is tudja tanusitvanyat a Windows tanusitvanytarban beallitani.

A Windows tandsitvanytarba a tanusitvany és kulcs importaldsanak folyamata a kévetkez6:

1. Ahhoz, hogy a gépén talalhat6 PKCS#12 dllomanyt telepitse, kattintson kétszer az
Intéz6bdl (Explorer) a *.pfx, (*.p12) kiterjesztést fajlra. Ekkor a tanusitvany telepitése
varazsl6 indul el.

2. Az 4dvozl6 képernyén nyomja meg a Tovabb (Next) gombot.

3. A masodik képerny6n az importalandé fajl nevét latja. Itt nincs semmi teendd, 1épjen

tovabb a Tovabb (Next) gomb x|
segitségével. Jelszo

A biztonsag kedvéért a személyes kulcsat jelszdval lehet védeni,

4. A kovetkezé képernyén adja meg a

PKCS#12 fijlhoz tart6z6 jelszot. Adja meg 2 szemelyes fulcs Jelszavat

117, . ;o ” Jelsza:
Itt allithatja be a tanusitvany erds [
védelmét és kés6bbi

3 H5404 1 [¥ Személyes kulcs erds védelmének engedélyezése. Ha engedélyez ezt

exportalhatosagat. Javasoljuk T e e e e
mindkét opciét kipipalni és ezutan e siamdes s
a TOVabb (NeXt) gombOt ¥ & kules megjelalés exportalhatdkeént, Ez lehetdvé teszi a kulcsok biztonsagi

mentéset &s atvitelst,

megnyomni.

< Yissza I Tovabb = I Mégse
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5. A kovetkezé képernyé megkérdezi, hogy automatikus vagy kézzel torténé elhelyezést
kivain a megfelel6 tanusitvanytaroloban. Itt valassza az Automatikus kivalasztast
(Automatically...), majd kattintson a Tovabb (Next) gombra.

6. Az utolsé képernyén kattintson a Befejezés (Finish) gombra.

A tanusitvany telepitése ezzel megtortént.
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8. Dokumentumok aldirisa

Az aldbbiakban a dokumentumok alairasat ismertetjiik Word2010-ben.
1. A dokumentum alairasat a Fajl menubdl vialaszhaté Informacié > Dokumentum
védelem > Digitalis alairas hozzaadasa opci6 kivalasztasaval tudjuk
kezdeményezni..

2. A kovetkez6 ablak jelenik meg:

MWid9-04l1- Dokumentum!
Fajl Kezdolap Beszuras Lap elrendezése Hivatkozas Levelezés Korrektura Nézet

= Mentés

e A(z) Dokumentum1 adatai
Bl Mentés maskeént

(£ Megnyitas Engedélyek
(' Bezaras @ Barki megnyithatjz, ja és médosithatja a d
barmely részét.
Dokumentumvédelem
=
Legutébbiak | < Megjeldlés véglegesként

Masok értesitése arrol, hogy a dokumentum végleges,
. illetve a dokumentum irasvédetté tétele
Ui

] Titkositds jelszéval | hogy tar
A asahoz jelszd Il
Nyomtatas i neve
b Szerkesztés korlatozasa
Mentés és kiildés | Meg szeretné adni, milyen tipusu valtoztatasokat |
é masok a dok
Sugo Engedélyek korlatozasa személyek szerint
élyek hozzaférésének biztositasa, egyuttal s * 6.
d Beallitasok masolasi és ny engedélyuk
e Digitalis aldirds hozzaaddsa
B3 Kitepés A o hes

digitalis alairas hozzaadasaval,

3. Alairni csak mar mentett dokumentumot lehet, amennyiben ez még nem tortént meg,
az alkalmazas figyelmeztet arra, hogy az alairas el6tt azt menteni kell

Microsoft Word

) Alairasok hozzdadasshoz digitslis alairdsokat tdmogatd Formatumban kell mentenie a dokumentumot.
Menti a dokumentumot Word-dokumentumként?

l Igen ] [ MNem ] [ Sugd ]
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4. A megjelené ablakban meg kell adnunk az alafras okat szévegesen, majd a Modositas
gombbal (Change) kivéalaszthatjuk a tanusitvanyt. Ha a megfelel6 van kivalasztva, az
Alairas (Sign) gombbal elvégezhet6 az alairas.

Aldirdssal készUl eldtni ezt 3
szovegében nem lesz [thatd.
A dokumentum aiérdsénak célje:

Az aldirds a

NézG:  Keler
Kidlito: Netlock Mndsitett Eat. (Class Q Legal) Taoie

Vélasszakiah
Tulajdonos: [ Révid név l
Elke1 nsz .. Ke moiS b’ Nincs. |
1
‘I

Eelen nse.

(had

)'w

[ ok ][ mégse | [Taniskvany megtekintése |

5. Amennyiben a szamitégépiinkre kriptografiai eszk6z6n tarolt (smart kartya, USB token)
tanusitvany korabban kertlt telepitésre, az operacios rendszer kéri az eszkéz behelyezést,
csatlakoztatasat, majd a PIN kod megadasat.

Aldirds [2][x]

Aldirds létrehozésa...

Please enter the passphrase to complete this
operation.

Pin code:

Number of tries left: 3

Cancel l

6. Az érvényes alairasrol a statusz sorban megjelend piros pecsét ikon tanuskodik. Ez utan
mentve az allomanyt, az alairtként ment6dik.

Page: 7 of 90 | Words: 8914 Hungarian | ﬂ |

8. Alairas utan a dokumentum nem lesz moédosithatd, a pecsét ikora kattintva, az Alairasok
szalagon megtekinthetjiik a dokumentumon talalhaté alairasokat, illetve azok indokat. A
modositashoz az alairast torolntink kell (Alairas eltavolitasa).

9. Ha egy dokumentumot tébb tanusitvannyal kivanunk alairni, ez megtehet6 a fenti médon,
az Osszes tanusitvanyt egyenként kivalasztva.
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9. Dokumentumok aldirdsinak megtekintése, ellendrzése

Alairt dokumentumon a megnyitasa utan a kovetkez6 helyen latszik, hogy alairt:

1. A statuszsorban talalhato pecsétre kattintva ellendrizhetd az alairas:

Page:70f90  Words:8914 | Hungarian | & |

- 8Xx
Alairas utan a dokumentum nem lesz moédosithatd, a pecsét
ikora kattintva az Alairdsok szalagon megtekinthetjuk a -~ A0 B
dokumentumon taldlhaté alafrasokat, illetve azok indokat =i [;::.:;es
(ehhez a legordilé meniib6l az Alafras részleteire kell szerkesttés
kattintani). A moédositashoz az alairast torélnink kell (Alairas 5 it T
eltavolitasa). - E"T_ﬁm;;os.

2 Ujbéli aldiras...
Alairas részletei,.
Alairas beallitasa..,

Alairas eltavolitasa
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10. Aliirdsi sor hasznilata

Az Alairasi mez6 (Signature line) koncepcidja az, hogy a felhasznilé egy dokumentumba ilyet
clhelyezve, az mind nyomtatasban megfeleléen nézzen ki, mind elektronikusan biztositson
lehetSséget az alairas elhelyezésére.

10.1. Aldirasi sor beszurdsa dokumentumba

A beszurashoz a Beszuras > Aldirasi sor (Insert > Signature line) mentpontot kell kivalasztani.
2| x| A megjelen6 ablakban kell megadnunk az

alairas killonb6z6 tulajdonsagait.

Varga Viktor e javasolt alafr6, (suggested signer) akitél

elvarjuk, hogy a mez6ben alairjon

dokumentacié készitd :) e javasolt alafr6 beosztasa (title)

e ajavasolt alairé email cime (e-mail address)
warga_v@netodk.hu

e utasitasok az alairénak (instructions)

Amit ide irunk jelenik majd meg az aldirast elhelyezdnek, Megjelélheté még két OpCié:

e az alair6 megjegyzéseket vehet fel az
Alairas parbeszédpanelen (Allow singer to
add comment...)

Signature Setup

e az alafras datumanak megjelenitése az
alairasi sorban (show sign date...)

Az Ok gomb megnyomasa utan valami ilyesmit kell latnunk:

Signatures 4
2 Requested signatures:
Varga Viktor

Ezegyszipiszupi-szerzddés, melyet+
vagydigitalisan,«'
vagykézzelmajdala-kellenedrni.f

- X =
Warga Viktor
dokumentacid készitd ;) q

Mint lathat6, az Alafrasok panelon is megjelent az elvart alairas.
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10.2. Alidirds elhelyezése az aldirdsi sorba

Figyelem, csak mentett dokumentumra helyezhetd be az aliras az alairasi sorba!

Az alairas elhelyezése egy ilyen mezébe gyerekjaték, csupan duplan kattintanunk kell a mezére, és
ekkor megjelenik egy ehhez hasonl6 ablak.

Sign 2|x|| A felsé6 dobozban megjelenik az a
szoveg, amit a mez6
létrehozasakor, mint Utmutatot az

alairashoz megadtunk.
Az alatta talalhaté részen KELL
vagy szovegesen megadnunk a

nevinket, vagy kivalasztanunk egy
képet az alafrasunkhoz.

@ See additional information about what you are signing. ..

Az als6 alafrasi cél (purpose) mez6

x Select Image. . csak akkor jelenik meg, ha a mez6

Varga Vikior beszurasakgr a megjegyzés

dokumentacis készits 1) hozzaflzési  lehetéség  opcidt
bekapcsoltuk.

Az legals6 aldiras mez6ben a
Moédositas  (Change)  gombbal
kivalaszthatjuk a tanusitvanyunkat,
llletve megvaltoztathatjuk az ott
éppen lathatét, ha az nem
megfeleld.

A lépések a kovetkezok:

1. A Kép kivalasztasa (Select image) opcidra kattintva tallézzuk ki a hasznalni kivant képet
vagy megadjuk az el6tte 1évé dobozba szovegesen a neviinket.

(Ez lehet akar a beszkennel alairasunk is, de biztonsagi okokbdl, figyeljiink arra, hogy a
felbontasa lehet6ség szerint ne legyen tulsagosan j6 minéségt, hiszen szkennelt alafrasunk
birtokaban nem elektornikus dokumentumokat azért még meg lehet hamisitani.)

2. Halehet, és van hozzafzni valonk, toltstk ki a megjegyzés mezot.

3. Ha nem a megfelel6 tanusitvanyt latjuk alul, valaszzuk ki a Mdédositas (Change) gomb
segitségével.
Nyomjunk ra az Alairas (Sign) gombra.

5. Ez utan tanusitvanyunknak megfeleléen a rendszer kérheti kartyan behelyezését és PIN
kod megadasat, vagy csak egyszerden elvégzi az alafrast. Az alairas utan a dokumentumot
automatikusan lementi, nem kell nekiink 4jra lementeni azt.
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10.3. Példa egy aldirt aliirdsi sorra

Példankban Varga Viktor mindsitett elektronikus alirasaval lattunk el egy révid dokumentumok,
¢és képként az alairashoz korunk legnagyobb ¢énckesndjének Britney Spearsnek alafrasat
vélaszottuk. (©)

“ Valid si
Varga Viktor 2007.08.27.

Ezegyszipiszupi-szerzddés,melyet+
vagydigitalisan,«
vagykézzelmajdala-kelleneirni.q

2007.06.27.

X BtL S,

Az alairt alairasi sorral rendelkezé dokumentumon, a megnyitasa utan tobb helyen latszik, hogy
alairt:

A statuszsorban (a képernyd aljan) talalhat6 pecsét:

Page:70f90  Words:8914 | Hungarian | & |

Alairas utan a dokumentum nem modosithatova valik, a pecsét ikora kattintva az Alafrasok
szalagon megtekinthetjik a dokumentumon talalhaté aldirasokat, illetve azok indokat. A
modositashoz az alairast torélniink kell.
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11. Fiiggelék A — Office 2010 PDF modul beillitisa szabvinyos PDF dllominyok
létrehozdsihoz

Az alabbiakban az Office 2010 bévitményeként szolgalé PDF modul beallitasait taglaljuk,
melynek segitségével szabvanyos formaban jonnek létre az egyes PDF fijlok. Ennek el6nye
(t6bbek k6zott) hogy a példaul a PDFSigno alkalmazassal is ala lehet irni ezeket.

A beéptl6-modul telepité csomagja let6lthet6 az alabbi cimek egyikérdl:

Magyar nyelvii Office 2007-hez:
http://www.microsoft.com/downloads/details.aspx?displavlang=hu&FamilyID=4d951911-

3e7e-4ae6-b059-a2e79ed87041

Angol nyelvii Office 2007-hez:
http://www.microsoft.com/downloads/details.aspx?displaylanc=en&FamilyID=4d951911-

3e7e-4ae6-b059-a2e79ed87041

A telepitést pozitiv helyeslé valaszadassal tovabb kell engedni, azt kévetSen az alabbi beallitisokat
szitkséges eszkozolni:

Az Office logéra kattintva > Mentés Masként > PDF vagy XPS > fajlnév megadasa > Beallitasok
> ISO 19005-1-kompatibilitas (PDA/A) > OK > Koézzététel (Mentés)
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Beallitasok

Oldalkartamany

11 Akkudlis oldal

@ ~ kijelslk beriilet
kizzéteendd

1@/ Dokumentum

@ Cokumentum korrekkdréwal

& nem nyomtatandd adatokkal egywitt
B ineevielzik 1Etrehozdsdnak alapia:
@ cCimsorak
@ word kinyvielzdk
Bl ~datlap
[V Kiseqitd dokumentumszerkezeti cimkék
PDF-beallitasok
[¥/] 150 19005-1-kompatibilis (POFIA)
Ml Eitképes széveq hasznalata, ha nem Agyazhatik be a bettitpusok

| Ok, I | Mégse

1. 4bra - Office 2007 "PDF vagy XPS'" modul beallitasa

17 18

fa '\ ) @D
0 \?«f)'c"e"rfop t’ NetLock Kft. cim: 1101 Budapest, Expo tér 5-7. postacim: 1439 Budapest, Pf. 663.

“n SGS 150 9001 telefon: +36 1437 6655 telefax: +36 1 700 2828 e-mail: info@netlock.hu web: www.netlock.hu



BY, NETLOCK

‘(‘ Az Elsé Hitelesités-szolgaltaté

Elektronikus alairas ld6bélyegzés = e-Szamlazas  e-Archivalas PKI tanacsadas és rendszerintegracio

www.netlock.hu

12. Fiiggelék B — Biztonsdgi mdsolat készitése tamisitvinyairol és kulcsairol

Ha tanusitvanya fokozott biztonsagu és NEM kriptografiai eszkézon kapta meg, akkor érdemes a
tanusitvanyar6l PKCS#12 (*.pfx) allomanyban biztonsagi masolatot késziteni, hiszen a
szamitogép sériilése, illetve Gjratelepitése utan csak ebbdl tudja a tanusitvanyt visszaallitani.

1. A kulcs és tanusitvany exportalasdhoz inditson Internet Explorer béngészot.

2. Navigiljon el a tanasitvanyok meniponthoz. (Eszkézok > Internet beallitisok >
Tartalom fil > Tanusitvanyok gomb) (Tools > Internet Settings > Content fil >
Certificates gomb)

3. Vilassza ki a Sajat (Personal) lapon a tanusitvanyok kéziil az exportalandét, majd nyomja
meg az Export gombot.

4. A megjelend tanusitvany exportalé varazslo idvozlé képerny6jén nyomja meg a Tovabb

(Next) gombot. |
. ” , ., A &l kulk tala
5. A kovetkez6 ablakban vélassza a privat kulcs e e s e
exportalasat is (Yes, export the private...), majd
kattintson a Tovabb (Next) gombra. A e A b e
6. A kovetkezd ablakban a masodik radibgombhoz e e b
, k ., , h . k 1 I ,Hi b % Igen, a személyes kulcs exportalasat valasztom
tartozo SZERCIO cr eto csa cL tt a tson € " hem, nem skarom exportlni a személyes kulcsomat

Er6s titkositast (Enable strong protection). Ha
szitksége van arra, hogy a tanusitvannyal egyiitt a B
hozza tartozé gyOkértanusitvanyt is exportalja, — eupordsiformseum

akkor jelblie kj a Minden tanﬁsitvény exportélésa A tanudsitvanyok kdbbféle fajlformatumban exportalhatdk.

opcidt (Include all certificates...) is. Ha a privat

“alassza ki a hasznalandd Formatumat:

kulcsot torolni akarja az exportalas utan errdl a £ Dl 509 1 G2
géprol, akkor jelolje be a privat kulcs torlése 2 Bk
. ., . £ Tjtkositoth Gzenetek szitaxisanak szativanya - PRCS #7 tantsitvanyak (*.R7E]
(Delete the Prlvate'") OPC1Ot 18. I Minden tantsit Ay belefoalalésa & bantsityAnylncha
.. o . , & P Sibesare - |
7. A kovetkez6 ablakban adja meg kétszer azt a e
. Minden tanusitvany belefoglalasa & kandsitvanylancha
]ClSZOt, amelyet szeretne a fa]lnak adni. Ez I¥ Eriis védelem (csak: IE 5.0, NT 4.0 5P4 vagy frissebb szoftver esetén)
jegyezze meg )(’)1 mert Cnnek ismeretében tud]a I személves kulcs torlése, ha a2 exportalas skertlt
bl

telepiteni masik gépen tandsitvanyat.
8. A kovetkezd ablakban kivalaszthatjuk a fajlnevet,
és a helyet, ahol a fajlt 1étre szeretnénk hozni.

< Vissza I Towabb = I Mégse

9. Miutan ezt beallitotta, mar csak a Tovabb (Next) és végiil a Befejezés (Finish) gombot kell
megnyomnia, valamint a megnyitott ablakokat OK gombbal bezarnia.

A tanusitvany exportalasa ezzel megtortént.

Ezt az allomanyt érdemes biztonsagos helyen elzarni valamilyen adathordozén.
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